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摘要摘要摘要摘要 

Shigella sonnei是台灣旅遊相關的主要腹瀉病原菌，常引發人口聚集

場所大規模的爆發流行事件。在北美洲，S. sonnei是常見的食因性病原，

經由糞口傳播，在衛生條件較差的國家與地區，是造成嬰幼兒腹瀉死亡的

主要病原。 

Pulsed-field gel electrophoresis (PFGE)是 PulseNet國際食因性疾病

分子分型監測網所採用的基因分型標準技術，然而 PFGE分析耗時、成本

高、產生影像資料，不利跨實驗室的比對，且分型效力不如multilocus 

variable number tandem repeat analysis (MLVA)，加上MLVA產生的資料

是簡單的數字，容易比對。然而，MLVA技術在防疫上的應用，仍需經由跨

實驗室的確效工作，決定共同的分析步驟與標準。本研究透過亞太地區

PulseNet組織的網絡，邀請日本、韓國、馬來西亞與印度的實驗室進行確

效工作。第一階段確效，共同決定 7個 VNTR loci (SS1, SS3, SS6, 

SS9,SS10, SS11, SS13)做為此一MLVA技術的分析標的。此 7個 VNTR 

loci具有高變異，可組合出至少 8.5 x 107基因型，能提供極高的分型效力。 

 

關鍵字：Shigella sonnei、亞太地區食因性疾病分子分型監測網、脈衝電泳、

多位址重覆序列分析
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Abstract  

Shigella sonnei, a primary travel-related pathogen of diarrheal 

diseases in Taiwan, occasionally causes large scale disease outbreak in 

crowded institutes. It is also one of the most common foodborne 

pathogens in North America. Since Shigella is transmitted from an 

infected person to another usually by a fecal-oral route, it causes child 

mortality due to diarrhea in countries or regions with poor sanitary 

condition.  

Pulsed-field gel electrophoresis (PFGE) is the standard molecular 

subtyping tool for PulseNet, a molecular subtyping network for foodborne 

disease surveillance. It is highly discriminatory but, in times, it is 

insufficient in discriminatory some epidemiologically unrelated isolates of 

monomorphic bacterial species. PFGE is also costly, labor-intensive and 

time-consuming and generates image data that is disadvantageous to 

pattern comparison among laboratories. Multilocus variable number 

tandem repeat analysis (MLVA) consisting only a small set of VNTR loci 

can have high discriminatory power over PFGE. MLVA generates simple 

integer data that are easy to analyze and compare among laboratories. 

However, to be a standard subtyping tool for disease surveillance, a 

MLVA protocol needs to be validated. In this study, an MLVA protocol is 

validated by laboratories of Japan, Korea, Malaysia and India. The phase 

I validation decided a common MLVA protocol consisting of 7 VNTR loci 

(SS1, SS3, SS6, SS9, SS10, SS11, SS13). The 7 VNTR loci can 

generate at least 8.5 x 107 genotypes that provide sufficient discriminatory 

power for subtyping S. sonnei isolates for disease surveillance and 

outbreak investigation. 

Keywords: Shigella sonnei, PulseNet Asia Pacific, pulsed-field gel 
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electrophoresis (PFGE), mulilocus variable-tandem repeat analysis 

(MLVA)  
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前言前言前言前言  

美國疾病管制中心(Centers for Disease Control and Prevention, CDC)

為了監控 Escherichia coli O157:H7的感染流行問題，於 1996年開始建立一

個全國性的食因性疾病實驗室分子分型監測網(A National Molecular 

Subtyping Network for Foodborne Disease Surveillance)，簡稱 PulseNet。

該監測網利用標準化的脈衝電泳(pulsed-field gel electrophoresis, PFGE)分子

分型技術，由各州公衛實驗室進行菌株的 PFGE指紋圖譜分析，再經由網路

將圖譜傳送到 CDC資料庫，集中進行圖譜比對，可達到早期偵測散發性食因

性疾病流行性感染事件(diffused foodborne disease outbreak) [1]。自 1998年

完成全國監測網建置之後，對 E. coli O157等食因性細菌病原引發的流行，監

測成效非常良好。基於防疫無國界之理念，該計畫主持人 Dr Balar 

Swaminathan開始將 PulseNet技術平台推廣至國際，首先在鄰國加拿大成立

PulseNet Canada，2002年在亞太地區成立 PulseNet Asia Pacific (有 13成

員國)的區域性監測組織，之後歐洲也成立了 PulseNet Europe (31成員國)，

南美洲成立了 PulseNet Latin America (13成員國)，最後在中東地區成立了

PulseNet Middle East (8成員國)；這些地區加上 PulseNet Canada與

PulseNet USA，合組成立了國際的 PulseNet International，是一個擁有 67

個成員國的龐大國際防疫組織
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(http://www.cdc.gov/pulsenet/participants.htm)。 

在 PNAP成員內，本實驗室在 PFGE分析能力與能量上，已居領先地位，

同時在新型分子分型技術的研發上，本實驗室成功發展出 S. sonnei [2]、

Shigella flexneri [3]、Salmonella enterica serovar Typhi 與 Salmonella 

Paratyphi A的MLVA技術，可利用這些技術平台為基礎，主導研究計畫的進

行。上述病原菌引發的疾病在台灣較為稀少，每年約只有數十例至 100-200

例，其中可能有半數以上是境外感染移入；然而，這些病原卻是亞洲許多國家

最主要的腹瀉疾病病原，東南亞與南亞各國皆相當重視。 

目前 PulseNet是以 PFGE做為菌株分型的標準工具。PFGE的技術主要

差別在使用的限制酶種類，同一限制酶可用於屬的層級(genus level)菌種，即

同一屬不同種的菌皆可用同一種限制酶進行 PFGE分析。然而，PFGE對一

些高度遺傳同質性的菌種，如 Escherichia coli O157 [4]、S. sonnei [2]、某

些 Salmonella Typhimurium strains [5]；MLVA是比 PFGE更細微的分型技

術，是屬於 species level 或 serovar level的分型技術，對一些 PFGE不易

區別的菌種，MLVA是一個被期待的下世代分型技術。但也因為MLVA為

organism-specific (species或 serovar-specific)層級的分型技術，研發工作相

當麻煩，必需針對每一 species或 serovar進行研發工作，找出具有變異的

VNTR loci。 
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2009年 12月在泰國曼谷舉行第六屆 PulseNet Asia Pacific年會，公佈

由 PulseNet Latin America所制訂之 Shigella flexneri PFGE standardized 

protocol，該標準操作流程改變了原先廣泛被使用的電泳跑膠條件。此操作條

件的改變，對台灣、韓國等擁有龐大 Shigella flexneri PFGE圖譜資料庫的國

家影響非常大，很可能新舊條件產生的 PFGE圖譜無法正確比對，或增加新

舊圖譜比對之誤差值。此次教訓，讓 PulseNet Asia Pacific成員有了制訂該監

測網組織新分型技術標準操作程序之急迫性與共識。在該(2009)年曼谷年會

中，決議通過美國疾病管制中心的 Dr. Peter Gerner-Smidt與 PulseNet Asia 

Pacific組織的召集人 Dr. Cam所提議成立的 Shigella Working Committee與

Salmonella Typhi & Salmonella Paratyphi A Working Committee，以協調

PulseNet Asia Pacific內成員，進行合作研究計畫與分型技術之評估與確效工

作。由於本實驗室已發展 S. sonnei、Salmonella Typhi 與 Salmonella 

Paratyphi A之MLVA方法，趁此機會，邀請 PulseNet Asia Pacific成員進行

這些病原之MLVA技術確效工作。基於 S. sonnei MLVA已有眾多菌株分析資

料，故優先進行該病原菌MLVA技術之跨實驗室確效工作，再視成效，進行後

續的 Salmonella Typhi 與 Salmonella Paratyphi A之MLVA標準操作方法的

確效工作。 

訂定國際 PulseNet監測網之標準分型工具，需將分型流程標準化，並進
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行內部與外部之評估與確效過程。本實驗室之前發展的 S. sonnei MLVA方法

擁有 26個 VNTR loci [2]，該MLVA方法已應用於分析收集自全球 5大洲 50

個國家之1,672株菌株，確定具有最高多樣性之8個VNTR loci，此8個VNTRs

能提供高於 PFGE之分型效力，因此選定此 8個 VNTRs進行跨國跨實驗室之

S. sonnei MLVA標準操作流程的確效評估研究。
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材料與方法 

一、 訂定 S. sonnei MLVA標準操作手冊(Standard Operation 

Procedures, SOP)。依據本實驗室使用的儀器(Applied Biosystems 

Genetic Analyzer 3130 XL)，撰寫 S. sonnei MLVA標準操作流程，

供參與國家使用。 

二、 第一階段確效工作：由本實驗室寄出 30株菌株(包括一株標準菌株)

與抽取之菌株 DNA樣本，寄送給參與確效工作的實驗室進行MLVA

分析。此批 30株菌株，將成為 S. sonnei MLVA技術的標準菌株，

協助各實驗室建立自己的分析系統。參與國家實驗室包括日本的國家

傳染病研究所(National Institute of Infectious Diseases)、韓國的

Center for Infectious Disease Research, National Institute of 

Health、馬來西亞的 University of Malaya與印度的 National Institute 

of Cholera and Enteric Diseases。參與實驗室回傳 ABI sequencer

之 DNA片段圖譜檔案，與轉換的 VNTRs序列重覆數目(copy 

number)，供比對實驗室分析之正確度與其解讀資料之能力。同時亦

要請參與實驗室回饋操作時所遭遇到的各式問題，供修正操作手冊之

用。 

三、 第二階段確效工作：通過第一階段試測之實驗室，將繼續進行第二

階段之測試，分析該國所分離之 40株菌株，primers由參與實驗室各
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自合成。參與實驗室將分析結果傳到本實驗室，並提供 20株菌株之

DNA樣本，由本實驗室進行分析，核對正確度。
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結果結果結果結果 

一、撰寫 S. sonnei MLVA標準操作手冊 

所撰寫之S. sonnei MLVA標準操作手冊：Laboratory Standard 

Operating Procedure for MLVA of S. sonnei – Applied Biosystems Genetic 

Analyzer 3130 XL Platform (附錄一)，係配合使用ABI 3130 XL毛細管電泳

儀所撰寫。使用500LIZ當做molecular size markers。由於個實驗室已建立

自己的分析系統，可依據此標準操作手冊，修改成該實驗室的操作方式。

在molecular size markers的選擇上，美國CDC因已撰寫使用幾個菌種(E. 

coli O157:H7, Salmonella Typhimurium等)的MLVA操作手冊，偏好使用

ROX625當做molecular size markers，有些實驗室則建議使用涵蓋範圍較

廣、參考分子標誌較多的600LIZ。本實驗室比較這幾個markers，認為都可

達到可接受的精確度(precise)，能穩定預估DNA片段大小，可無困難轉換

成相對應的copy number。 

二、第一階段確效工作 

於8月中旬寄出30株測試菌株與抽取之DNA到參與實驗室，包括日本、

韓國、馬來西亞與印度。10月下旬，日本、韓國與馬來西亞寄回測試結果，

印度則到11月中旬經數次摧促，仍未回覆結果。 

日本所回覆之結果中，有一株菌株有兩個loci (SS12與SS13)沒有資料

與一個locus(SS6)鑑定錯誤。日本實驗室重覆試驗，並將annealing 

temperature 調回標準操作手冊所建議之溫度，得到預期之正確結果。 

馬來西亞由University of Malaya的Professor Kwai-Lin Thong進行測

試，Thong教授一直代表馬來西亞參與PNAP。Thong教授回覆之結果，有
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4個loci錯誤，10株菌株的SS1沒有資料，9個loci為double bands，其中有6

個發生在SS12。馬來西亞偵測到SS12有明顯double bands的結果，經詢

問日本實驗室的經驗，告知該實驗室也得到類似的結果，只是bands的大小

相差甚大，而挑選大的band為結果。該實驗室重覆試驗，10株SS1沒有資

料與3株具double bands的loci已解決，但6個有double bands的SS12，一

樣有double bands產生，且bands的大小差異不大。 

韓國實驗室為了參與這次的測試，購買一台ABI 3130 XL毛細管電泳

儀，於11月初才回覆結果。韓國實驗室資料錯誤較多，包括SS1有10株、

SS3有1株、SS6有14株、SS9有9株、SS12有7株、SS13有4株。檢視其

未轉換為copy number的DNA片段長度資料，發現除了SS6有1株資料不

符、SS12的7株有double bands的選擇錯誤外，其它皆是DNA片段長度轉

換成copy number時發生的錯誤。該錯誤是誤將儀器利用500LIZ的

molecular size markers估算出來的長度當做DNA片段的真正長度，加以計

算copy number。事實上，這類具有重覆序列的DNA片段，在電泳所呈現出

來的長度，大多比實際長度短，轉換為copy number時，需對照標準操作手

冊所提供的實際長度給予計算。 

三、 第二階段確效工作 

第二階段確工作，預定於十二月初開始進行。日本與馬來西亞皆已正

確分析第一階段確效工作的30株菌株，可開始進行第二階段的確效工作，

分析至少40株最近分離之菌株，並將20株的DNA寄到本實驗室分析。 

初步大家已同意排除SS12，只分析7個VNTR loci (SS1, SS3, SS6, 

SS9, SS10, SS11, SS13)，做為分析S. sonnei的MLVA標準。日本已開始

使用此一MLVA標準，進行國內菌株之分析，日前寄送一個爆發流行事件菌



 13 

株的MLVA資料，希望和台灣國內之S. sonnei菌株庫資料相比對(圖一)。比

對資料庫內1,701株菌株資料，與日本爆發流行事件的菌株無MLVA圖譜相

同者，8株菌株有4個VNTR loci相同，此8株菌株於2001-2007年分離自阿

根庭、越南與台灣(表一)。 
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討論討論討論討論 

本計畫是第一次執行自行研發之細菌(S. sonnei)新型分子分型技術

(MLVA)跨國確效工作。確效的過程，由參與的實驗室共同決定該細菌的基

因分型標準，參與國家自然會採用該技術，因此可推廣該技術，成為國際

共同採用的標準，促進防疫合作的機會。美國 CDC亦已取得此一技術之標

準操作手冊，未來將和美國 CDC合作，將此標準列為 PulseNet國際食因

性疾病監測網分析 S. sonnei菌株的標準基因分型工具。 

MLVA和 PFGE比較，除了MLVA有較高的分型效力(discriminatory 

power)之外，MLVA分析速度快、成本較低且可快速分析大量菌株，最重要

的，得到的資料是以簡單的數字(copy number)表達，容易傳輸與分析比

對。另外，MLVA是 PCR-based的技術，只要少量 DNA即可分析，不像

PFGE需要大量的活菌方可分析。因此，MLVA容易透過寄送 DNA，即可

進行跨國的合作研究，提昇國際合作的意願。在美國 911炭疽孢子信件攻

擊事件之後，具感染性的生物材料進出口皆困難重重，更強化MLVA技術

的優勢。 

第一階段的確效工作，發現 8個 VNTR loci中的 SS12在某些菌株有

double bands的情形。在參與的國家反應後，回頭檢視舊有的資料，的確

有少數菌株有此一情形。雖然 double bands有大小的差別，但馬來西亞的

PCR條件，所增幅出來的 double bands大小差不多。此一發現，推測少數

菌基因體應該有兩個 SS12。因此，參與實驗室建議將 SS12排除。第一階

段確效工作因此決定，此一MLVA技術將分析 7個 VNTR loci (SS1, SS3, 

SS6, SS9, SS10, SS11, SS13)。依據過去分析來自 5大洲 50個國家的

1,672株菌株所得到的結果，此 7個 VNTR loci分別擁有 16、30、29、17、
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9、8、5個 alleles。理論上，此 7個 VNTR loci將可組合成 8.5 x 107個基

因型，可提供足夠的分型效力。  

有了簡間容易操作的分型工具，國際間的實驗室就有交換資料的願

意。例如，日本國家傳染病研究所目前已開始使用此一MLVA SOP分析國

內的 S. sonnei菌株，且願意和台灣分享資料，日前即透過 email，傳來資

料希望和台灣的菌株比對(圖一)。 

執行跨國實驗室一項技術的確效工作，對我們是一個新的挑戰。由於

各實驗室的環境條件不同，同步執行，相當困難，工作時程時有拖延難以

前進的情形。加上菌株進出口的行政程序複雜，本來預定 5月初在完成操

作手冊之後即開始執行的第一階段確效工作，拖到 8月才開始執行。參與

的日本與韓國皆是國家的防疫機構，設備齊全，且該技術將被用於常規分

析國內之 S. sonnei菌株；馬來西亞是一個大學的實驗室，未來只能接受國

家防疫機構的委託(馬來西亞的國家防疫機構沒有動機建立技術，歷年來皆

由該大學的 Thong教授與 PNAP合作)，在未來合作上效果可能不彰。印度

實驗室在多次摧促下，仍無回應，第二階段確效工作，可能會將之排除。



 16 

結論與建議結論與建議結論與建議結論與建議 

1. 第一階段 S. sonnei MLVA SOP確效工作，結果決定了 7個 VNTR loci 

(SS1, SS3, SS6, SS9, SS10, SS11, SS13)，做為未來的MLVA分析標

的。該 7個 VNTR loci可決定至少 8.5 x 107個基因型。未來，將使用

此一共同的標準，常規性分析我國所分析之 S. sonnei菌株。 

2. 有了共同的分子分型技術，台灣可利用此一平台，和日本、韓國建立

合作架構，共同監測 S. sonnei的感染。特別是台灣、日本與韓國的

S. sonnei感染，大多源於東南亞、印度與中國等地。 
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    99    年度計畫重要研究成果及具體建議 

計畫名稱：亞太地區 PulseNet組織合作研究計畫：食因性細菌病原分

子流行病學監測(III) 

主 持 人：_邱乾順__________ 計畫編號：DOH99-DC-2016        

 

1.計畫之新發現或新發明 

本計畫是第一次執行自行研究之細菌(Shigella sonnei)新型分子分型技

術(MLVA)之跨國確效工作。由跨國實驗室建立共同的 S. sonnei基因分型

技術，可推廣該技術，做為國際共同採用的基因分型標準，促進合作防疫

的機會。 

 

2.計畫對民眾具教育宣導之成果 

 

3.計畫對醫藥衛生政策之具體建議 

疾病管制局可用此一具有 7個 VNTR loci的MLVA標準分型方法，常規性

地分析國內分離之 S. sonnei菌株。也可利用此一平台，和日本、韓國建立

合作架構，共同監測S. sonnei的感染。特別是台灣、日本與韓國的S. sonnei

感染，大多源於東南亞、印度與中國等地。 
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圖表圖表圖表圖表 

 
 

圖一、日本國家傳染病研究所 Dr. Hidemasa Izumiya來信要求和本局比對

台灣 Shigella sonnei菌株之MLVA圖譜。 
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表一、日本流行菌株MLVA圖譜與本局資料庫符合度最高之 8株菌株 

Key  year SourceCountry SS1 SS3 SS6 SS9 SS10 SS11 SS13 

Subject 2010 Japan 9 15 13 11 3 4 4 

586/02 2002 Argentina 9 12 16 6 3 4 4 

587/02 2002 Argentina 9 12 16 6 3 4 4 

shCCN  2001 Taiwan    9 18 10 7 3 4 4 

Vn23   2007 Vietnam   9 24 16 7 3 4 4 

Vn46   2006 Vietnam   9 25 17 7 3 4 4 

Vn47   2006 Vietnam   9 25 18 7 3 4 4 

Vn55   2007 Vietnam   9 25 17 7 3 4 4 

Vn60   2007 Vietnam   9 24 16 7 3 4 4 
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附錄一、Laboratory Standard Operating Procedure for MLVA of Shigella sonnei – 

Applied Biosystems Genetic Analyzer 3130 XL Platform 

 

1. PURPOSE: to describe the standardized laboratory protocol for molecular 

subtyping of S. sonnei 

 

2. SCOPE: to provide the PulseNet participants with a single protocol for performing 

MLVA of S. sonnei, thus ensuring inter-laboratory comparability of the generated 

results.  

 

3. DEFINITIONS:  

3.1 MLVA: Multilocus variable-number tandem repeat analysis  

3.2 VNTR: Variable-number tandem repeat  

3.3 DNA: Deoxyribonucleic acid  

3.4 DNase: Deoxyribonuclenase 

3.5 PCR: Polymerase chain reaction  

3.6 dNTP: Deoxyribonucleotide triphosphate  

3.7 SOP: Standard Operating Procedure  

 

4. RESPONSIBILITIES/PROCEDURE  

4.1. Biosafety warning: S. sonnei is a human pathogen capable of causing 

serious disease. Always use a minimum of Biosafety Level 2 practices and 

extreme caution when transferring and handling strains of this pathogen. 

Work in a biological safety cabinet when handling large amounts of cells. 

Disinfect or dispose of all plastic ware and glassware that come in contact 

with the cultures in a safe manner. 

4.2. Reagents, supplies and equipment needed for DNA template preparation 

4.2.1 Trypticase soy agar (TSA) or comparable media 

4.2.2 Inoculation Needle (Copan, Code# 176CSR40) 

4.2.3 1.5 ml microcentrifuge tubes  

4.2.4 DNase-free, molecular biology -grade water 

4.2.5 Vortex 

4.2.6 Boiling water bath or Dry bath accommodating 1.5 ml tubes 

4.2.7 Tabletop centrifuge 

4.2.8 Pipets (200 µl) for aliquoting 100 µl of DNase-free, molecular 

biology-grade water  
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4.2.9 Filtered sterile pipet tips 

4.3. Reagents, supplies and equipment needed for PCR  

4.3.1 DNA lysates from isolates (keep at -20ºC or -80ºC freezer for long 

term)  

4.3.2 PCR primers (see Appendix Table 1)  

4.3.2.1 Fluorescent-labeled forward primers  

4.3.2.2 Unlabeled reverse primers  

4.3.2.3 Applied Biosystems sells primers labeled with the four dyes 

needed for the protocol  

4.3.2.4 Divide the concentrated stocks in portions and store at -80ºC 

freezer  

4.3.2.4.1 One vial should contain enough to prepare 25-50 µl of 

working solution. Avoid repetitive freeze-thaw cycles of 

concentrated primer stocks.  

4.3.2.5 The working solutions can be stored at either -20ºC or -80ºC 

freezer  

4.3.2.6 Prepare primer mix solutions (100 µl) as follows: 

Primer mix 

(100 µl) 
Locus Primer/H20 

Working 

solution (µM) 

Volume 

(µl) 

Final conc. 

in mix (µM) 

Final conc. 

in PCR (µM) 

SS1-F 100 1 1 0.05 
SS1 

SS1-R 100 1 1 0.05 

SS3-F 100 2 2 0.1 
SS3 

SS3-R 100 2 2 0.1 

SS6-F 100 4 4 0.2 
SS6 

SS6-R 100 4 4 0.2 

SS9-F 100 2 2 0.1 
SS9 

SS9-R 100 2 2 0.1 

M1 

  H20   82     

SS10-F 100 1 1 0.05 
SS10 

SS10-R 100 1 1 0.05 

SS11-F 100 1 1 0.05 
SS11 

SS11-R 100 1 1 0.05 

SS12-F 100 5 5 0.25 

M2 

SS12 
SS12-R 100 5 5 0.25 
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SS13-F 100 1 1 0.05 
SS13 

SS13-R 100 1 1 0.05 

  H20   84     

4.3.2.7 Divide primer mixes into aliquots and store at either -20ºC or 

-80ºC freezer. Use new primer mixes every month or if a 

significant drop in the fluorescence level is observed  

 

4.3.3 96-well polypropylene PCR plates (Axygen, Cat. No. PCR-96M2-HS-C) 

or Microamp PCR tubes without caps (Applied Biosystems, Cat. No. 

N8010533)  

4.3.4 8-well strip caps for the polypropylene plate Axygen, Cat. 

No.PCR-02CP-C) or MicroAmp strip caps for the individual tubes 

(Applied Biosystems, Cat. No. N8010535)  

4.3.5 DNase-free, molecular biology-grade water  

4.3.6 1.5 ml Eppendorf microcentrifuge tubes  

4.3.7 dNTP mixture (dNTP mix containing all four nucleotides; BioVan, Cat. 

No. BV105)  

4.3.8 Taq Polymerase and 10X buffer (BioVan, Cat. No. TQ1000)  

4.3.9 25 mM MgCl2 (Roche, Cat. No. 11699113001) 

4.3.10 PCR Cooling block (VWR International, Cat. No. 62111-762)  

4.3.11 DNA Engine (Biorad), GeneAmp (Applied Biosystems) or similar 

thermocycler with a heated lid option and 96-well block format  

4.3.12 Parafilm M, 4” width (VWR, Cat. No. 52858-032)  

4.3.13 Complete set (1000 µl, 200 µl, 100 µl, 20 µl,10 µl and 2 µl) of single 

channel pipettors for mastermix set-up (“clean set”)  

4.3.14 10 µl and 100 µl single channel pipettors for preparing and adding 

DNA templates  

4.3.15 Filtered tips for pipettors 

4.4. Reagents, supplies and equipment needed for Genetic Analyzer 3130XL  

4.4.1 DNase-free, molecular biology-grade water  

4.4.2 PCR Cooling block (VWR International, Cat. No. 62111-762)  

4.4.3 10 µl, 100 µl, and 1000 µl single channel pipettors  

4.4.4 10 µl and 200 µl multichannel pipettors  

4.4.5 Filtered pipette tips  

4.4.6 Sterile solution basins  

4.4.7 1.5 ml Eppendorf microcentrifuge tubes  

4.4.8 96-well polypropylene PCR plates (for dilutions; Axygen, Cat. No. 
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PCR-96M2-HS-C)  

4.4.9 MicroAmp Optical 96-well reaction plates (Applied Biosystems, Cat. No. 

N801-0560)  

4.4.10 96-well plate base (Applied Biosystems, Cat. No. 4317237)  

4.4.11 Rubber septa for 96-well reaction plates (Applied Biosystems, Cat. No. 

4315933)  

4.4.12 96-well plate retainer (Applied Biosystems, Cat. No. 4317241)  

4.4.13 Hi-Di Formamide, 25 ml (Applied Biosystems, Cat. No. 4311320)  

4.4.14 GeneScan 500LIZ Size Standard (Applied Biosystems, Cat. No. 

Number 4322682) 

4.4.15 Multi-Capillary DS-33 (Dye Set G5) Matrix Standard Kit (Applied 

Biosystems, Cat No. 4345833)  

4.4.15.1 Needed periodically to establish the system dye color spectra 

for the instrument  

4.4.16 3130XL & 3100 Capillary Array 36 cm (Applied Biosystems, Cat. No. 

4333464)  

4.4.17 10X Running Buffer with EDTA, 25 ml (Applied Biosystems, Cat. No. 

402824)  

4.4.18 3130XL POP7 Performance Optimized Polymer, 3.5 ml (Applied 

Biosystems, Cat.No. 4363785)  

4.4.19 Parafilm M, 4” width (VWR, Cat. No. 52858-032)  

4.4.20 A rinse bottle containing distilled water  

4.4.21 Centrifuge with a microtiter plate rotor  

4.4.22 Thermal cycler or heating block for denaturation  

4.5. Isolate and DNA template preparation 

4.5.1 Day 0:  

4.5.1.1 Streak an isolated colony from test cultures to TSA plate (or 

comparable media). Incubate cultures at 37ºC for 14-18 hrs.  

4.5.2 Day 1:  

4.5.2.1 For each isolate to be typed, aliquot 100 µl of sterile, molecular 

biology-grade water into 1.5 ml microfuge tubes. Use a sterile, 

disposable inoculation needle to scratch 1 colony or 1 µl loop to 

pick 2-3 colonies (about half of a loopful); stir the inoculation 

needle or agitate/rotate the loop in a microfuge tube to release 

the bacteria into the water. Cap and vortex for 10-15 seconds to 

disperse any clumps.  

4.5.2.2 Place the tubes in a 100ºC heat block or water bath for 10 
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minutes. Cool briefly on ice or in fridge and centrifuge for 1 

minutes at 15,000 rpm. Place on ice or in fridge while preparing 

PCR reactions. These DNA templates can be stored at - 20ºC 

or -80ºC for several years.  

4.6. PCR procedure  

4.6.1 Day 1:  

4.6.1.1 Fill out, save with the run name, and print a PCR template 

worksheet (see Appendix Table 2) with appropriately labeled 

samples (a maximum of 46 unknown isolates/plate + one 

positive control [DNA of strain C07.0755] and one negative 

control)  

4.6.1.1.1 For each isolate, two wells must be labeled as follows: “ID_M1” 

where “ID_M1” represents the isolate ID (be sure to use the 

exactly same isolate ID that is used in the PFGE gels 

uploaded to BioNumerics database) and “M1” represents one 

of the two specific multiplex PCR reactions (M1, M2).  

4.6.1.2 Fill out, and print a PCR mastermix calculation worksheet (see 

Appendix Table 3) by typing the number of isolates to be 

tested (plus 2-3 extra) in the PCR mastermix calculators 

labeled M1 and M2. This number is highlighted in RED and is 

next to “number of samples to be analyzed”. The mastermixes 

for reactions M1 and M2 for one sample are as follows: 

Reagent Volume (µl) Final conc. 

PCR water 4.9 — 

DMSO (10%) 1 1% 

PCR buffer (10 X) 1 1X 

MgCl2(25 mM) 0.6 3 mM* 

dNTP (2.5 mM) 0.8 0.2 mM  

Primer mix (M1 or M2) 0.5 various 

Tag (5 u/µl) 0.2 1 U/9µl 

Total 9   

*1X Buffer contains 1.5 mM MgCl2  

 

4.6.1.2.1. NOTE: these primer concentrations serve as a starting 

point. Since laboratory-specific factors, such as the age of 

the primer stocks, calibration status of the thermocyclers 
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and pipettes, etc. affect amplification efficiency, each 

laboratory will have to re-optimize the primer 

concentrations for optimal detection of all targets. However, 

any other parameters stated in the SOP should not be 

changed.  

4.6.1.3 Thaw all reagents and supplies needed for PCR reactions and 

place on ice; keep primers light protected as much as possible  

4.6.1.3.1 NOTE: PCR mastermixes should be set up in a clean 

hood that is dedicated just for this purpose and where no 

cultures or DNA are handled  

4.6.1.4 Prepare the two separate PCR mastermixes in 1.5 ml Eppendorf 

tubes following the instructions in the PCR mastermix 

calculation worksheet (see Appendix Table 3). Keep the 

mastermix on ice while preparing. Add the mastermix 

components in the following order: water, DMSO, 10x PCR 

buffer, MgCl2, dNTPs, primer mix (M1 or M2), and then finally 

Taq polymerase. Mix the reaction mixture by vortexing briefly.  

4.6.1.4.1 NOTE: All components except Taq polymerase should be 

vortexed thoroughly before adding to the mastermix. Taq 

may be briefly centrifuged, if necessary to pull the enzyme 

down to the bottom of the tube  

4.6.1.5 Place a 96-well PCR plate or required number of PCR tubes in a 

PCR cooling block  

4.6.1.6 Dispense 9.0 µl of each mastermix into the appropriate rows of 

the 96-well polypropylene plate / PCR tubes as noted in the 

PCR template worksheet (see Appendix Table 2)  

4.6.1.7 Add 1.0 µl of DNA lysate to each of the two different wells 

representing the two PCR reactions. Use S. sonnei strain 

C07.0755 as a positive control and water as a negative control.  

4.6.1.8 Cover all wells / tubes with 8-well strip caps and firmly clamp 

down to avoid any evaporation during PCR amplification  

4.6.1.9 Recommendation: briefly spin down the plate / tubes to remove 

any air bubbles  

4.6.1.10 Setup the following PCR parameters and save the program as 

“SSMLVA”  

 

* 94ºC for 5 min   Step 1  
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* 94ºC for 45 sec   Step 2  

* 55ºC for 50 sec   Step 3  

* 72ºC for 60 sec   Step 4  

* Go to step 2, 29x  Step 5  

* 72ºC for 5 min   Step 6  

* Indefinite hold at 25ºC Step 7  

 

4.6.1.10.1 NOTE: Make sure to use the heated lid option on the 

PCR block and tube (calculated) temperature control  

4.6.1.11 When the PCR is complete store the amplification products 

light-protected at 4ºC until ready to run on the sequencer. If the 

fragment analysis is not performed the same day, the plate 

should be stored at -20ºC or -80ºC. The PCR products are 

stable for approximately one month, when stored frozen.  

4.7. Initial setup of Genetic Analyzer 3130XL instrument:  

4.7.1 Turn on the computer, which is connecting to 3130XL, set up Gene 

Mapper v4.0 

4.7.1.1 Double-click on the shortcut icon for GeneMapper v.4.0 and 

enter the appropriate password to access the software. The 

main menu window will open 

4.7.1.2 Set up the size standard: 

4.7.1.2.1 From the “Tools” drop-down menu, select “GeneMapper 

Manager”. A “GeneMapper Manager” window will open. 

4.7.1.2.2 Select the “Size Standards” tab  

4.7.1.2.3 Click on “New”, leave the default option “Basic or 

Advanced” checked and click “OK”. “Size Standard Editor” 

window will appear.  

4.7.1.2.4 Name the new size standard “500LIZ”  

4.7.1.2.5 Leave the default option “Orange” as “Size Standard Dye”  

4.7.1.2.6 Enter sizes for each peak in the table  

4.7.1.2.7 When finished, click “OK” 

4.7.1.3 Set up analysis method: 

4.7.1.3.1 From the “Tools” drop-down menu, select “GeneMapper 

Manager”. A “GeneMapper Manager” window will open.  

4.7.1.3.2 Select the “Analysis Methods” tab  

4.7.1.3.3 Click on “New”, leave the default option “Microsatellite” 

checked and click “OK”. “Analysis Methods Editor” window 
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will appear.  

4.7.1.3.4 Name the new method “SSMLVA” and click “OK”  

4.7.1.3.5 Highlight the new method name “SSMLVA” and click 

“Open”  

4.7.1.3.6 Select the “Peak Detector” tab and change “Peak 

Detection Algorithm” to “Advanced” from the drop-down 

menu  

4.7.1.3.7 Input the following analysis settings and click “OK” when 

finished: 

4.7.1.3.7.1 Analysis: Full Range  

4.7.1.3.7.2 Sizing: Partial Sizing 

4.7.1.3.7.2.1 Start Size: 60 

4.7.1.3.7.2.2 Stop Size 600 

4.7.1.3.7.3 Smoothing: none 

4.7.1.3.7.4 Baseline window: 51 pts  

4.7.1.3.7.5 Size Calling Method: Local Southern Method 

4.7.1.3.7.6 Peak Amplitude Thresholds 

4.7.1.3.7.6.1 B: 100 

4.7.1.3.7.6.2 G: 100  

4.7.1.3.7.6.3 Y: 50  

4.7.1.3.7.6.4 R: 100  

4.7.1.3.7.6.5 O: 50 

4.7.1.3.7.7 Min. Peak Half Width: 2 pts 

4.7.1.3.7.8 Polynomial Degree: 3 

4.7.1.3.7.9 Peak Window Size: 15 pts  

4.7.1.3.7.10 Slope Threshold 

4.7.1.3.7.10.1 Peak Start: 0.0 

4.7.1.3.7.10.2 Peak End: 0.0 

4.7.2 Turn on the power of Analyzer, wait until the Status Light turns to Green. 

Click on the “Run 3130XL Data Collection v 3.0” icon of the computer. 

The “Service Console” window will appear. If the connections are 

functioning properly, the “Messaging Service”, “Data Service”, 

“Instrument Service” and “Viewer” icons will change from red circles to 

green squares. The main window of the “Foundation Data Collection” 

software will open. Check to make sure system status is green.  

4.7.3 NOTE: steps 4.7.4 and 4.7.5 only need to be performed before the very 

first run  
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4.7.4 Set up a results group:  

4.7.4.1 On the left side of the window under “GA Instruments”, highlight 

“Results group” and click on “New”.  

4.7.4.2 The “Results Group Editor” window will appear  

4.7.4.3 Under “General” tab, name the new results group as “SSresults”  

4.7.4.4 Under “Analysis” tab, select “GeneMapper-Generic” from the 

“Analysis type” drop-down menu. Leave “Analysis actions” 

unchecked  

4.7.4.5 Under “Destination” tab, keep the default root destination 

(E:\AppliedBiosystems\udc\DataCollection\Data)  

4.7.4.6 Under “Naming” Tab, select “Sample Name” from the first 

“Sample File NameFormat” drop-down menu, and select “Plate 

Name” from the first “Run Folder Name Format” drop-down menu. 

Leave all other fields blank.  

4.7.4.7 Under “Automated Processing” tab, leave the default “Only when 

the results group is complete” checked  

4.7.5 Set up running conditions:  

4.7.5.1 Under “GA Instruments”, click on + to expand “ga3130XL” 

subfolders  

4.7.5.2 Highlight “Protocol Manager”. The instrument protocols will be 

listed on the right side of the window.  

4.7.5.3 Click on “New”, and the “Protocol Editor” window will appear 

4.7.5.3.1 Name the new protocol “SSTest”  

4.7.5.3.2 Leave the protocol type as “Regular”  

4.7.5.3.3 From the “Run Module” drop-down menu, select 

“Fragment Analysis 36_POP7_1” as running conditions  

4.7.5.3.3.1 NOTE: These are the instrument default running 

conditions for 36 cm capillary array and POP7 

polymer. You can check the running conditions and 

modify them by highlighting “Module Manager” 

subfolder under ga3130XL and by double clicking 

on the protocol name. The default conditions are:  

4.7.5.3.3.1.1 Oven_Temperature: 60ºC  

4.7.5.3.3.1.2 Poly Fill Vol: 6500 Steps  

4.7.5.3.3.1.3 Current Stability: 5.0 µAmps  

4.7.5.3.3.1.4 PreRun_Voltage: 15.0 kVolts  

4.7.5.3.3.1.5 Pre-Run-Time: 180 sec.  
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4.7.5.3.3.1.6 Injection_Voltage: 1.2 kVolts  

4.7.5.3.3.1.7 Injection_Time: 23 sec.  

4.7.5.3.3.1.8 Voltage_Number_Of_Steps: 20 nk  

4.7.5.3.3.1.9 Voltage_Step_Interval: 15 sec.  

4.7.5.3.3.1.10 Data_Delay_Time: 60 sec.  

4.7.5.3.3.1.11Run_Voltage: 15.0 kVolts  

4.7.5.3.3.1.12 Run time: 1200sec.  

4.7.5.3.4 From the “Dye Set” drop-down menu, select “G5” as dye 

set  

4.8. Genetic Analyzer 3130XL instrument preparation before each run  

4.8.1. Day 1  

4.8.1.1 Make sure service console is open and all components are 

green. Make sure a capillary array is installed in the instrument. 

For installation, follow the instructions of the “Install Array 

Wizard”. You can find the wizards by expanding the 3130XL 

subfolder and by highlighting “Manual Control”. The “Wizards” 

drop-down menu will appear on top of the window.  

4.8.1.2 Setup the plate run on the 3130XL 

4.8.1.2.1 Under the ga3130XL, highlight “Plate Manager” 

4.8.1.2.2 Click on “New” and a “New Plate Dialog Window” will 

appear 

4.8.1.2.3 Name the run following a standardized naming system: 

use the unique identifier code that was assigned to 

operator of laboratory for the first two letters of the file 

name. The next two spaces will indicate the year and the 

next four spaces will indicate the month and the date the 

run was performed. For example YW100426 is a run made 

by an operator “YW”on April 26th 2010. If several runs are 

performed the same day, separate the file names by using 

sequential numbers, for example YW100426-1, 

YW100426-2. 

4.8.1.2.4From the “Application” drop-down menu, select 

“GeneMapper-Generic” 

4.8.1.2.5 Type in the Owner Name and the Operator Name 

4.8.1.2.6 Click “OK” and the “GeneMapper Plate Editor” window will 

appear 

4.8.1.2.6.1 Type in the sample IDs  
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4.8.1.2.6.2 Select “SSresults” from the “Results Group 1” 

drop-down menu for the first sample, highlight the 

results group column, and select “Fill Down” from 

the “Edit” drop-down menu  

4.8.1.2.6.3 Select “SSTest” from the “Instrument Protocol 1” 

drop-down menu, highlight the instrument protocol 

column, and select “Fill Down” from the “Edit” 

drop-down menu  

4.8.1.2.6.4 Select ”500LIZ” from “Size standard” 

4.8.1.2.6.5 Select “SSMLVA” from the Analysis Method 

4.8.1.2.6.6 Select “None” from Panel 

4.8.1.2.6.7 Select “Sample” from Sample Type 

4.8.1.2.6.8 Click “OK”  

4.8.1.3 Install the POP7 polymer in the instrument  

4.8.1.3.1 Expand the 3130XL subfolder and highlight “Manual 

Control”. The “Wizards” drop-down menu will appear on 

top of the window.  

4.8.1.3.2 Follow the instructions of the “Replenish Polymer Wizard”  

4.8.1.3.2.1 NOTE1: if an old polymer (been in the instrument > 

7 days) is switched to a new one follow the 

instructions of the “Water Wash Wizard” instead. 

Use distilled water that has been heated to 37-40ºC 

for water wash.  

4.8.1.3.2.2 NOTE2: water wash should be performed once a 

week  

4.9. Fragment analysis sample preparation  

4.9.1 Day 1  

4.9.1.1 Thaw the Hi-Di Formamide, the 500LIZ DNA size standard and 

place on ice.  

4.9.1.1.1 NOTE: aliquot Hi-Di Formamide (500 µl/tube) and the size 

standard (50 µl/tube) in order to avoid frequent 

freeze-thaw cycles.  

4.9.1.2 Prepare a 96-well plate for diluting the PCR reactions. Using a 

200 µl multichannel pipettor and a solution basin, dispense 19 

µl of molecular-grade water in the required number of wells.  

4.9.1.3 Remove the plate / tubes with the PCR reactions from the 

thermocycler. Briefly spin down the plate / tubes, if necessary. 
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Use a 10 µl multichannel pipettor to transfer 1 µl of each PCR 

reaction directly across to the corresponding set of wells in the 

dilution plate. In order to avoid cross-contamination, remove the 

strip cap from just one column at a time and recap the column 

before opening the next one.  

4.9.1.4 Using a 200 µl multichannel pipettor, mix the dilutions by 

pipetting up and down a few times. Cover the plate with parafilm 

and put in the fridge or on ice.  

4.9.1.5 Prepare a fragment analysis master mix containing DNA size 

standard and Hi-Di Formamide for the samples. The fragment 

analysis mastermix can be calculated as follows. Vortex briefly 

and place on ice.  

Reagents  Frag. anal. mastermix  

Hi-Di Formamide  9 µl x (# samples +3)=  

500LIZ size standard  0.1 µl x (# samples +3)=  

 

4.9.1.6 Place a MicroAmp Optical 96-well sample plate in a cold block. 

Aliquot 9 µl of the prepared fragment analysis mastermix to the 

required number of wells. Cover the plate loosely with Parafilm.  

4.9.1.7 Using the 10 µl multichannel pipettor, add 1 µl of 1:20 diluted 

PCR reactions to the appropriate columns in the sample plate. 

Keep sliding the Parafilm sheet from column to column to keep 

track of the sample order. 

4.9.1.8 Denaturate templates by heating the reaction plate in a 

thermocycler at 95ºC for 3 min, and place on ice immediate. 

4.9.1.9 While the templates denatured, prepare 30 ml 1X running buffer 

with EDTA and turn the oven of the 3130XL on using Manual 

Control. Change set point to 60ºC.  

4.9.1.9.1 Add 3 ml of 10X Running Buffer with EDTA in a 50 ml 

graduated cylinder  

4.9.1.9.2 Add purified water to bring the total volume up to 30 ml 

4.9.1.9.3 Mix well by inverting  

4.9.1.10 Briefly spin down the sample plate to remove any air bubbles  

4.9.1.11 Place the sample plate in a plate base. Seal the plate with the 

rubber septa. Snap the plate retainer onto the plate and the 

plate base.  
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4.9.1.12 Place the plate assembly and the buffer into the Genetic 

Analyzer 3130XL.  

4.9.1.12.1 Push on the “Tray” button at the front of the Genetic 

Analyzer 3130XL to bring the autosampler to the forward 

position. Open the instrument doors.  

4.9.1.12.2 Place the plate assembly on the autosampler in position 

A or B with the notched end of the plate base away from 

you  

4.9.1.12.3 Add 1X running buffer to the anode and cathode 

reservoirs  

4.9.1.12.4 Add distilled water to the waste and rinse reservoirs  

4.9.1.12.5 Close the instrument doors and wait for the green light to 

illuminate 4.9.1.13. Start the run after making sure the 

system status is green.  

4.9.1.13.1 Expand 3130XL computer name icon.  

4.9.1.13.2 Highlight “Run Scheduler”  

4.9.1.13.3 Click on “Find All”  

4.9.1.13.4 Highlight the plate name for the run  

4.9.1.13.5 Link the plate by clicking on the yellow squares on the 

right side of the window  

4.9.1.13.6 The “Start Run” button will turn green indicating that the 

run can be started. Click on this button, and then click 

“OK” on the alert window. The run will start.  

4.10. Viewing and exporting data from the Genetic Analyzer 3130XL  

4.10.1 Day 2  

4.10.1.1 Double-click on the shortcut icon for GeneMapper v.4.0 and 

enter the appropriate password to access the software. The 

main menu window will open. 

4.10.1.2 From the “File” drop-down menu select “Add Samples to 

Project” 

4.10.1.3 Find the folder containing the data file to be analyzed: My 

Computer → E: → Applied Biosystems → UDC → 

DataCollection → Data  

4.10.1.4 Highlight the desired file(s) and click on “Add to List”. File(s) will 

appear in the window on the right. Click “Add & Analyze” below 

the file list to return to the original screen  

4.10.1.5 Name the project with the run name (for example, “YW100426”) 
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and click “OK” 

4.10.1.6 A successful analysis is indicated by green squares. Yellow 

triangles indicate problematic components (i.e. missing size 

standard peaks). Red circles indicate results fell below 

acceptable quality values. Samples with yellow or red circles in 

the SQ column should be selected for re-analysis. 

4.10.1.6.1 To resolve failed analyses due to sub-optimal molecular 

marker peak profile (i.e. miscalling of peaks), select a row 

with a yellow triangle or red circle in the SQ column and 

click on the “Size Match Editor” icon on the toolbar. “Size 

Match Editor” view will appear. 

4.10.1.6.2 Place the cursor near the X-axis to activate the 

magnifying lens, and then pull up (mouse left-click and 

hold) to zoom in a specific area to facilitate editing. 

4.10.1.6.3 Left-click at the base of a peak to select. Right-click and 

select “Add”, “Delete”, or “Change”. 

4.10.1.6.4 Select the correct molecular weight for the selected peak 

from the drop-down menu. Repeat this process for all 

other miscalled peaks. Click “OK” when finished. 

4.10.1.6.5 After the size standard has been adjusted, click the 

“Play” button to re-analyze the data. After a successful 

analysis, the samples will have green squares under the 

SQ column. If the size standard cannot be adjusted, the 

reaction is considered a fragment analysis failure and 

must be re-run. 

4.10.1.7 Check the fragment result data (the fluorescent peaks) for each 

well by highlighting the well ID and by clicking on the “Display 

Plots” icon on the toolbar. Make sure that all eight VNTRs 

amplified in the C07.0755 control and that the fragment size is 

within ±1 bp from that specified in the Appendix Table 4. Write 

down any failed reactions in the PCR/ABI worksheet. Make a 

note of non-specific bands and primer-dimers.  

4.10.1.8 Export the peak file: 

4.10.1.15.2 NOTE: the following columns should appear in the 

exported table in the following order from left to right: 

“Dye/Sample”, “Sample file name”, “Marker”, “Size”, 

“Height”, “Area”, “Data point”. The format of the table can 



 35 

be modified by selecting “Table setting editor” from the 

“Tools” drop down menu. Select the “Genotype” tab and 

make sure that the boxes for the above mentioned 

columns are checked and no additional boxes are 

checked.  

4.10.1.8.2 Highlight the samples for which you want to export peak 

data  

4.10.1.8.3 Click on “Display Plots” icon on the toolbar  

4.10.1.8.4 Click on “Sizing Table” icon on the toolbar and a table will 

appear below the electropherograms  

4.10.1.8.5 From the “File” drop-down menu, select “Export Table”  

4.10.1.8.6 Select the location (for example a flash drive) where you 

want to export the data  

4.10.1.8.7 Name the export file with the run name (for example 

YW100426) and make sure the file type is tab-delimited 

text (.txt) file  

4.10.1.9 The remaining gel can stay in the instrument if it is going to be 

used within seven days  

4.10.1.10 Convert the sizes of fragments into copy numbers (see Excel 

file: S. sonnei worksheet_Copy number and amplicon sizes) 

4.10.1.11 Note: Sequencing is recommended to confirm the copy 

number of an amplicon with an unexpected size. The flanking 

regions for the VNTRs used in this protocol are listed in the 

Excel file: S. sonnei worksheet_Flanking regions 
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Appendix Table 1.  

S. sonnei MLVA PCR primers.  

Locus Dye_Forward primer (5’ to 3’) Reverse primer (5’ to 3’) 

M1   

SS1 VIC_TTGCCAGTACACCTCACTCG GCGTCGGCGTTAATATCACT 

SS3 6-FAM_CTGGGAGATGAACAGGAGGA ATGCCAGCGACAAGTTTCTT 

SS6 NED_GAGTCGCTAAACGCTTGCTT GGGAAATAGAGCGGACCTTT 

SS9 PET_CGCAATCAGCAAAACAAAGA GCGATGCTGGAAAAACTGAT 

M2   

SS10 6FAM_ACGGTGGGCTTTCTCTACCT GCGAGGGGGAGATCAGTATT 

SS11 VIC_CTGGTCCGGGAGATTATCG CTGTTTCAGCGGTCTCTTCC 

SS12 NED_GCTGTAGGCACGGAAAAGAA TGGATATTGTGCAGGGTTCA 

SS13 PET_AGACGCTGGCTTATGACGAT GCCACTGTCCTGAATGGTCT 

 

Appendix Table 2  

S. sonnei MLVA PCR Template and ABI worksheet (see Excel file: S. sonnei 

worksheet_PCR template) 

PCR run date: 

PCR instrument: 

ABI run date: 

ABI instrument: 

 

  1 2 3 4 5 6 7 8 9 10 11 12 

A                         

B                         

C                         

D                         

E                         

F                         

G                         

J                         

 

Appendix Table 3  
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Mastermixes for PCR M1 and M2 (see Excel file:S. sonnei worksheet_Mastermix 

calculator) 

 

Technician: 

S. sonnei multiplexes PCR M1 & M2 

20 Number of (X) samples to be analyzed 

10  µl Total Reaction Volume 

  
Volume (µl) 

 for 1 sample 

Conc. in  

PCR reaction 

Volume (µl) 

 for X samples 

PCR water 4.9 — 98 

DMSO (10%) 1 1% 20 

PCR buffer (10 X) 1 1X 20 

MgCl2(25 mM) 0.6 1.5 mM 12 

dNTP (2.5 mM) 0.8 0.2 mM 16 

Primer mix  M1 or M2 0.5  10 

Tag (5 u/µl) 0.2 0.1 u/µl 4 

Total 9   180 

 

Appendix Table 4  

Sizes of VNTRs for positive control strain C07.0755 

Size estimated by  
Multiplex Locus Repeat_bp Copy no. Size_amplicon_bp 

500LIZ* 600LIZ ROX625 

SS1 7 15 230 216.01 213.95 216.48 

SS3 7 17 233 230.02 227.65 231.29 

SS6 7 24 320 314.83 311.44 317.5 
M1 

SS9 6 9 215 215.6 213.31 216.11 

SS10 6 3 198 194.61 191.6 194.39 

SS11 6 4 199 197.21 194.33 197.04 

SS12 9 2 188 184.93 181.54 184.74 
M2 

SS13 6 3 236 236.73 234.79 238.73 

* Marker 250 bp is not included as recommended by the Supplier. 

 


